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CSiBridge® 2016 (Version 18.0.1) 

Release Notes 
© Copyright Computers and Structures, Inc., 2015 

Notice Date: 2015-11-12 
 

 

This file lists all changes made to CSiBridge since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant.  

 

Version 18.0.1 was released shortly after v18.0.0 to address several issues with the initial release of v18. For this 

reason the Release Notes for v18.0.0 are also included in this file. 

Changes from v18.0.0 (Released 2015-10-30) 

Miscellaneous 

Enhancements Implemented 

* Incident Description 

 85446 The version number has been changed to v18.0.1 for a new minor update. 

User Interface and Display 
Incidents Resolved 

* Incident Description 

* 85432 An incident was resolved in which the 64-bit version of the program could take a minute or more to 

launch on certain machines. This is a result of Microsoft's JIT (just-in-time) compiler and not a bug 

in the software. Not all systems are equally affected, and newer versions of the Windows (8.1 and 

10) tend to be less affected, especially if Windows Updates are current. A new tool, 

CSiNativeImageGen is available to 'precompile' the software after installation, prior to use. In most 

cases this should resolve the slow startup time, as well as speed up the displaying of forms. 

CSiNativeImageGen is available in the installation folder and must be Run As Administrator. 

Information on the use of this optional tool is provided within CSiNativeImageGen itself using t he 

Help command, and by searching the CSI Knowledge Base at wiki.csiamerica.com for 'native image 

generation'. 

Loading 
Incidents Resolved 

* Incident Description 

* 85382 

85534 

An incident was resolved in which the assignment of area loads to frames was actually being 

assigned as area uniform loads instead of area loads to frames. The analysis results would reflect the 

area uniform loads, and usually no load was lost. 

 85607 An incident was resolved where the diaphragm widths in X and Y directions were flipped when 

calculating the torsion due to specified additional eccentricity for response spectrum cases . 

Frame Design 

Incidents Resolved 

* Incident Description 

* 85333 

85386 

An incident was resolved in which the steel frame design results could be incorrect and/or the right -

click design details were not able to be viewed when using the 64-bit version on certain machines. 

When results were available they could appear reasonable even if they were not correct. All steel 
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* Incident Description 

frame design codes could be affected. This only affected v18.0.0, 64-bit. The 32-bit version was not 

affected. 

* 85387 An incident was resolved in which the Eurocode 3-2005 steel frame design was incorrect for box 

sections. Models with box sections designed in v18.0.0 should be redesigned. No other versions 

were affected. 

* 85520 An incident was resolved for AISC 360-10 steel frame design in which the compression capacity of 

box, pipe, rectangle, circle, general, and section designer sections was being taken equal to the 

tension capacity, ignoring the compression capacity due to flexural buckling. This error could 

overestimate the compression capacity of these type of sections. This only affected models designed 

in v18.0.0. 

 
Results Display and Output 
Incidents Resolved 

* Incident Description 

 85453 An incident was resolved in which the graphical display of results on a limited selection of the 

model was taking extra time to display. This was a performance issue only and did  not affect 

results. 

 85587 An incident was resolved in which the date on the report cover page was not correct. 

Data Files 

Incidents Resolved 

* Incident Description 

* 85367 An incident was resolved in which trying to import frame section properties from a *.pro library file 

would generate an abnormal termination when the *.pro file was located in a folder without write 

permissions, which is usually the case for the default installation location. 

 



CSiBridge 2016 v18.0.0 2015-10-28 Page 1 

CSiBridge® 2016 (Version 18.0.0) 
Release Notes 

© Copyright Computers and Structures, Inc., 2015 

Notice Date: 2015-10-28 
 

 

This file lists all changes made to CSiBridge since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v17.3.0 (Released 2015-07-06) 

User Interface 
Enhancements Implemented 

* Incident Description 

* 64943 A full 64-bit version of CSiBridge is now available. The 32-bit version can be installed on either a 

32-bit or 64-bit operating system, while the 64-bit version requires a 64-bit operating system. 

* 69107 

72353 

An enhancement was implemented to add an Apply button to the Select and Assign command forms 

and allow them to remain open (floating) for continual use. 

 81561 An enhancement was implemented to allow user-defined paths to the location of the libraries for 

vehicles and frame-sections (currently only for precast-I and -U girders) using the File > Settings > 

Other Settings command. Library files will now be discovered in order of the following three 

locations:  1) CSiBridge installation \Libraries subfolder,  2) User-defined folder using Other 

Settings,  3) Local user settings folder for CSiBridge. In the case of conflicting definitions for a 

given vehicle or frame section name, the last one found will be used. For example, a definition 

found in the local user settings folder will overwrite a definition found in the installation folder. 

Graphics 
Enhancements Implemented 

* Incident Description 

* 41385 

69876 

The DirectX graphics performance has been enhanced, especially for larger models containing 

many points. 

* 81474 DirectX graphics has been updated from DirectX 9 to DirectX 11. This may affect the graphics 

cards that are supported, particularly on older machines. 

 
Bridge Modeler 

Enhancements Implemented 

* Incident Description 

* 24363 User-defined bridge sections can now be created in the Bridge Modeler and used to generate 

parametric bridge objects. Bridge sections are defined as a series of polygons representing different 

materials and openings. Each polygon can have an arbitrary number of vertices, and each vertex 

may optionally be given a radius to specify fillets and rounds. Any of the predefined bridge sections 

may be used as a template and converted to a user-defined section. User-defined sections can be 

edited in a table, in Microsoft Excel, or modified graphically in Section Designer. Parametric 

variations may be applied to user-defined sections to create non-prismatic sections along the length 

of the bridge. Bridge objects containing user-defined sections can only be updated as spine models 

in this initial release, and superstructure design is not applicable at the present time. All other bridge 

features are applicable, including curved layout, moving-load analysis, and construction scheduling. 
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* Incident Description 

* 69537 

71727 

80425 

80644 

The Bridge Modeler has been enhanced to more accurately define the geometry in the vicinity of a 

skewed support, diaphragm, or in-span hinge in the case where the bridge is curved and/or there is 

parametric variation of the bridge section at the skew. Previously, the parametric variation was 

calculated based on the non-skewed section (i.e., perpendicular to the layout line), and then 

projected onto the skewed section. This projection was exact at the layout line and at the outer edges 

of the section, but was interpolated between the layout line and the edges. The accuracy of this 

projection was generally good except in the case of large skews in in the presence of significant 

curvature of the layout line and/or significant parametric variations. Now the geometry is calculated 

for each point in the section directly along the skew, rather than being interpolated as before. For 

most models there will be little effect upon results. In any case, results for previous versions agreed 

with the model as generated from the bridge object. 

* 81913 An enhancement was made to no longer discretize frame objects that are representing bridge 

superstructure spine objects, based on tendon discretization. All other frame objects remain as they 

were before. The previous discretization was excessive due to the number of tendons in the models. 

* 82767 A new construction scheduling wizard has been added for segmental bridge objects. Working with a 

bridge object that has been defined using the segmental bridge wizard, construction travelers and a 

construction schedule can be quickly and easily created. Once the schedule has been generated, it 

can be modified in detail using the staged-construction scheduler, from which staged-construction 

load cases are created for analysis. Travelers are modeled automatically as frame elements having 

user-specified stiffness and weight. For spine models, these can support precast and cast-in-place 

construction. For area and solid models, these can support precast construction directly, and cast-in-

place construction with additional modeling provided manually by the user. 

Modeling 
Enhancements Implemented 

* Incident Description 

* 14367 A new two-dimensional concrete model has been added to the nonlinear layered shell. This model is 

based on the Darwin-Pecknold model, with consideration of Vecchio-Collins behavior. This model 

represents the concrete compression, cracking, and shear behavior under both monotonic and cyclic 

loading. The direction of cracking can change during the loading history, and the shear strength is 

affected by the tension strain in the material. The given material stress-strain curve is simplified to 

account for initial stiffness, yielding, ultimate plateau, and strength loss due to crushing. Zero 

tensile strength is assumed. The layered shell allows this material to be used for membrane and/or 

flexural behavior and to be combined with steel reinforcement in arbitrary directions and locations. 

Transverse (out-of-plane) shear is assumed to be elastic. 

* 70714 An enhancement has been implemented to provide access to a set of additional frame and shell 

templates for quick generation of non-bridge geometry. 

* 80135 An enhancement has been implemented to add two new capabilities to the Modify Undeformed 

Geometry feature, namely, 1) It is now possible to specify a coordinate system and one or more 

directions (X, Y, Z) to limit the direction in which the target displacement modification is applied. 

2) It is now possible to limit the modification, using either the target displacement or scaled mode-

shape option, to a selection of joints. 

* 80281 An enhancement has been implemented adding a new template for generating cable-stayed bridge 

models. 

 83286 An enhancement has been implemented to update the Russian material library to modify the 

concrete ultimate strain values. 
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Loading 
Enhancements Implemented 

* Incident Description 

* 72215 An enhancement was implemented to include standard vehicles in the vehicle libraries to represent 

AASHTO legal loads used for load rating, as defined in the AASHTO Manual for Bridge 

Evaluation. 

 72234 An enhancement has been made to exclude the mass at restrained joints from being considered 

when computing the total mass for automated equivalent static seismic loads. Stiff springs should be 

used instead of restraints if such mass is to be included. 

Analysis 
Enhancements Implemented 

* Incident Description 

* 68919 

70348 

The handling of convergence tolerances for time-dependent behavior during staged-construction 

analysis has been improved to better enforce equilibrium after large load increments have been 

applied. Previously the convergence tolerance used to measure equilibrium during the time-

dependent phase of a stage was relative to the magnitude of the load applied in that stage and 

previous stages. Now the convergence tolerance for the time-dependent phase is relative only to the 

internal creep and shrinkage effects themselves, and does not depend on the magnitude of any 

externally applied loads. This will have little effect on most models, but may improve the 

equilibrium for certain models without needing to tighten the convergence tolerance for the entire 

load case. It is always recommended that the effect of convergence tolerance upon results be 

examined when developing any nonlinear model. 

* 75659 A new stability check has been added for nonlinear load static cases. For force-controlled load 

cases, including staged construction, the stiffness matrix will be formed, solved, and checked at the 

final converged state for negative eigenvalues. The number found will be reported in the analysis 

log file (.LOG), and a stability warning issued in the log file if the number is greater than zero. 

Displacement-controlled load cases are not checked as these typically are used to analyze unstable 

structures, whereas force-controlled load cases are intended to be stable. 

 
Bridge Design 

Enhancements Implemented 

* Incident Description 

 65601 Superstructure design and rating for steel I-girder bridges using the AASHTO LRFD codes has been 

enhanced for consideration of the moment-gradient factor Cb. Previously this factor was always 

being taken as unity. Now, by default, a more detailed calculation of Cb is performed according to 

AASHTO clause 6.10.8.2.3. Optionally, the user can specify a fixed value of Cb to be used for a 

given design or rating request. For all AASHTO LRFD codes, the affected design requests are 

Steel-I Composite Strength, Steel-I Composite Construction Staged, and Steel-I Composite 

Construction Non-Staged; and the affected rating requests are Steel-I Composite Strength and Steel-

I Non-Composite Strength. 

* 80134 Superstructure design has been updated to now include the new CSA S6-14 code in addition to the 

existing CSA S6-06 code. 

 83038 A minor enhancement was made to Bridge Design Optimization (for steel I-girder and U-girder 

bridges) so that the "Unlock" and "New File" operations are only enabled in the Select Option form 

that appears after clicking the OK button if the Current version of the plates sizes and stiffeners 

have been saved in the As Designed version by executing "Recalculate Resistance." Once 

"Recalculate Resistance" has been executed the first time, the "Unlock" and "New File" operations 

will be available, and any new changes made in the Current version will be discarded in favor of the 

As Designed version unless "Recalculate Resistance" is again executed. This behavior is 

documented on the Select Option form. 

* 83109 An enhancement has been implemented to specify the location of splices along the span length of 

steel I-girder bridge sections. The specification includes the net-to-gross area ratio for the top and 
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* Incident Description 

bottom flanges, which is used to reduce the flange area at these locations for AASHTO flexural 

design checks. In order for these to be effective, user-defined discretization points must be added at 

each of these locations where a section cut is not already present. Splices do not affect analysis 

results. Two additional tables for these design results are now provided for the Steel-I Comp 

Strength design request for the AASHTO LRFD 2012 and 2014 codes with all Interims whenever 

splices are defined. 

* 83805 An enhancement has been implemented for AASHTO superstructure design of steel I-girder bridge 

sections to report the total nominal shear force per Clause 6.10.10.4.2 in order for users to be able to 

determine the number, size, and spacing of shear studs required. An additional table for these design 

results is now provided for the Steel-I Comp Strength design request for the AASHTO LRFD 2007, 

2012, and 2014 codes with all Interims. 

* 83944 An enhancement has been implemented for AASHTO superstructure design of steel I-girder bridge 

sections to compute the top and bottom-flange tensile stress ranges due to vertical bending and 

bottom-flange lateral bending. These stress ranges can then be considered by the user to verify 

AASHTO LRFD load-induced fatigue criteria according to Clause 6.6.1.2.2. An additional table for 

these design results is now provided for the Steel-I Comp Fatigue design request for the AASHTO 

LRFD 2007, 2012, and 2014 codes with all Interims. 

 

Frame Design 

Enhancements Implemented 

* Incident Description 

 76864 The handling of effective-length K-factors has been changed for steel frame design with the "AISC 

360-10" and "AISC 360-05" codes when the Analysis Method is set to "Direct Analysis". 

Previously the bending factors K22 and K33 were always taken as 1.0, and the lateral-torsional 

buckling factor K_LTB was taken as an internally calculated value for K22, which was generally 

greater than 1.0 and usually over-conservative. Furthermore, these factors were always being used 

and could not be changed by the user. Now the default values for all three factors (K22, K33, and 

K_LTB) are taken as 1.0, but these can be changed by the user by assigning design overwrites to 

specific frame members. This change only affects the design using the Direct Analysis Method. 

* 81910 A change has been made to remove older design codes which have been superseded. Models with 

older code assignments will now use the latest corresponding design codes. The following older 

codes have been removed: For steel frame design "AISC-ASD01" and "CAN/CSA-S16-01"; and for 

concrete frame design "ACI 318-05/IBC2003". 

 

Results Display & Output 
Enhancements Implemented 

* Incident Description 

* 11549 The vehicles acting on each lane and their longitudinal position may now be shown in the Bridge 

Superstructure Response form when viewing the force, moment, or stress response for any moving 

load case. This information is presented in tabular format for any section cut location on the bridge 

object. The contribution to the total response from each lane is also shown. 

* 34729 An enhancement has been made so that contour plots are now available for frame axial stresses. 

Contour values are plotted as colors on the line or the extruded shape of the frame objects based on 

the extrusion setting. When plotted on the line the color represents the maximum axial stress in the 

cross section. The axial stresses are the S11 components due to axial force plus bi-axial bending 

moment, and are provided for all load cases except influence-based moving-load cases. Stresses are 

calculated for the base material, and do not account for modular ratio. Stresses are computed for the 

section property assigned to the frame object, and do not account for the possibility that the section 

has been changed during staged construction. 

* 84141 

84466 

An enhancement has been made so that contour plots are now available for frame deflections. 

Contour values are plotted as colors on the line or the extruded shape of the frame objects based on 

the extrusion setting.  
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Application Programming Interface 
Enhancements Implemented 

* Incident Description 

* 82060 The CSiBridge API has been updated for v18 (2016) such that both v17 (2015) and v18 (2016) can 

coexist on the same machine. API tools and plugins written using the v17 API will need to be 

recompiled after changing the reference to CSiBridge18.dll. 

Installation and Licensing 
Enhancements Implemented 

* Incident Description 

 71757 The license manager for network licenses has been updated to Sentinel RMS 8.6. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 81074 The version number has been changed to v18.0.0 for a new major release. CSiBridge v18 will be 

known as CSiBridge 2016. 
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User Interface and Display 
Incidents Resolved 

* Incident Description 

 82700 An incident was resolved where an abnormal termination error could occur when attempting to 

review superstructure design requests after running the superstructure design while the model was 

still locked. This was a user interface issue that did not affect results, which could be accessed by 

restarting the software. 

Bridge Modeler 
Incidents Resolved 

* Incident Description 

 80940 An incident was resolved for the Bridge Modeler where a moment release specified at the top of a 

bent column could be improperly modeled if a joint from another part of the model was coincident 

with the bent column. This could happen, for example, in the case where a bearing lies directly 

above the column and the bottom of the superstructure lies below the centerline of the bent cap. In 

this case the link created to connect the bearing to the bottom of the superstructure has a joint that 

lies on the column. Previously, the bent column was automatically meshed at this joint, and the 

moment release was placed in the top element inside bent cap instead of at the bottom of the bent 

cap. Now the bent column will no longer be automatically meshed at joints created by the Bridge 

Modeler itself. Manually create joints may still have this effect, and manual adjustments will need 

to be made to achieve the desired behavior. This issue was not common. 

 80979 An incident was resolved for the Bridge Modeler where an error message "The support name at the 

ends of the spans needs to be unique!" was sometimes generated after clicking the OK button in the 

Bridge Object Abutment Assignments form. This error did not occur if the span names were 

changed or the Bridge Object Bent Assignments form was used before using the Bridge Object 

Abutment Assignments form, and hence was not common. When this error occurred it was 

necessary to restart the software. No results were affected. 

 81616 An incident was resolved for the Segmental Bridge Wizard where a bridge tendon could not be 

defined for a segmental bridge object if the bridge object had been renamed after the model was 

created. 

 81814 An incident was resolved in the bridge modeler in which the link/support property could be missing 

in a bridge bearing that was defined using a Link/Support Property if any of the program-generated 

"fixed" link properties were assigned to this bridge bearing and the linked bridge model was then 

updated. 

 82044 

83641 

83840 

An incident was resolved for the Bridge Modeler that corrected two issues affecting the use of 

General bearing locations in the bent assignments, i.e., bearings not at default Girder-by-Girder 

locations:  1) If a bent property was used at the start abutment, specifying General bearing locations 

was ignored at that abutment, and the bearings were always placed at the default Girder-by-Girder 

locations. This did not affect the start abutment when using an abutment property, and it did not 

affect the end abutment.  2) When General bearing locations were used at a bent and the number of 

bearings specified was greater than the number of girders at that bent, some of the bearings at 

subsequent bents may not be generated. These issues affected version 17.3.0 only; previous versions 

did not support the General bearing location. 

 82191 An incident was resolved in which the name of precast concrete U-girder frame sections could not 

be modified after being added. This was a user interface issue only. 

 83066 An incident was resolved for the Bridge Modeler where staggered diaphragms would not be created 

correctly within a span having a steel I-girder bridge section for the particular case where two or 

more staggered diaphragms in that span were assigned the same distance from the start of the span 

and the reference lines for these diaphragms were all set as the right-side girder of the diaphragm. 

When this occurred, the error was obvious and results agreed with the model as generated. 

 83700 An incident was resolved for the Bridge Modeler where the polygons used to represent the spine 

model of a steel I-girder bridge section with non-prismatic hybrid steel I-girder frame sections could 

be created incorrectly such that there was a small gap between the web and each flange in the hybrid 

frame section. The flanges were correctly located, and the gap was equal to the flange thickness, 
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* Incident Description 

and reduced the height of the plate representing the web. When this occurred, the overall sections 

properties for the spine model of the bridge section could be calculated incorrectly, primarily 

affecting the moment of inertia I33 and the shear area A2. In turn this could affect analysis and 

design results. However, the error was small and the effect insignificant and conservative. Note that 

non-prismatic hybrid steel I-girder frame sections are always created whenever changes are made to 

the I-girder webs or flanges during superstructure optimization using the commands Design/Rating 

> Superstructure Design > Optimize or Design/Rating > Load Rating > Optimize. 

Modeling 
Incidents Resolved 

* Incident Description 

 43466 

80127 

An incident was resolved where, in certain rare cases, it was not possible to draw a long vertical 

cable. Drawing the cable as several shorter vertical segments would work. Other minor issues 

related to drawing cables were also resolved where the drawn shape would not appear symmetrical 

or could exhibit small oscillations at one end. This could result in unequal segment lengths if the 

cable was subdivided, or in the appearance of unexpected deflections. However, analysis results 

were always correct and consistent with the length of the drawn cable as shown in the Cable 

Geometry form and the Cable Shape Data database table. Results are not affected, except that the 

displayed deformed shape of the cable may appear different in certain cases. The actual deformed 

shape of the cable, its tension, and its action on the rest of the structure are unchanged. 

Loading 
Incidents Resolved 

* Incident Description 

* 80765 An incident was resolved where the centrifugal moving load calculated for a moving load case 

could be zero in certain cases. This occurred due to errors interpolating the lane centrifugal radius, 

which caused the radius to be set to zero, indicating a straight lane. When this occurred the error 

was obvious because the centrifugal results were zero. 

 81506 

82584 

83709 

An incident was resolved where incorrect values were displayed in the textboxes on the Tendon 

Response Form. This was a display issue on this form only and did not otherwise affect the results. 

 82981 An incident was resolved in which the default AASHTO HL-93F vehicle in the vehicle library had 

an incorrect scale factor on the axle loads, causing the loads to be much larger than necessary. The 

results agreed with the scale factor that was imported and shown in the model. This scale factor has 

been changed from the previous 26.6 to 1.15, where 1.15 represents a 15% increase over the 

nominal axle loads to account for impact. 

Analysis 
Incidents Resolved 

* Incident Description 

* 80931 An incident was resolved where the results of a moving load case could be incorrect for vehicles 

where the option "Vehicle Remains Fully in Lane" was selected. This error, although not common, 

could occur in versions 17.2.0 and 17.3.0. Moving load cases containing such vehicles should be re-

run with the new version to confirm the results. Multi-step linear static load cases for vehicle loads 

were not affected, only influence-based moving load cases. 

* 80942 

81196 

81569 

81820 

81912 

An incident was resolved where the analysis could terminate abnormally in certain rare cases while 

running moving load cases due to exceeding memory resources. When this occurred, results were 

not available. This error could also occur after the analysis was completed but when accessing 

analysis results for display or for superstructure design/rating. When this occurred, certain results 

were not available. Results that were available were not affected by this error. 
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Bridge Design 
Incidents Resolved 

* Incident Description 

 80766 An incident was resolved that could affect the calculation of the live-load distribution factors 

(LLDF) for bridge design and rating of precast I-girder and U-girder bridge sections using the 

AASHTO design code. Previously the longitudinal stiffness parameter Kg (AASHTO LRFD eq. 

4.66.2.2.1-1) was being calculated using the precast girder area and moment of inertia converted by 

the modular ratio to the material of the composite slab. The Kg parameter is used to determine live 

load distribution factors for moments for interior beams and skew correction factors for moments 

and shear. This only affected Precast I-girder and U-girder sections when the modulus of elasticity 

was different between the slab and the precast girder. Affected design and rating checks are the 

Precast I and U Beam w/ composite Slab - Flexure and Shear, for all editions of the AASHTO 

LRFD code. 

 81565 An incident was resolved where in some models with vehicle live or wave load patterns the seismic 

bridge design resulted in an error message and the seismic design could not be completed. 

 81716 An incident was resolved in which a response spectrum function could be deleted when it was 

already assigned to a seismic design request. Deleting the function would cause errors when trying 

to run the bridge seismic design and no results would be generated. 

 82260 An incident was resolved for the bridge design and rating of steel I-girder and U-girder bridges 

where running design or rating requests terminated with an error message for models containing 

multiple spans having different numbers of girders and the change in the number of girders occurred 

at a location without a bent support. When this error occurred, design/rating results were not 

available. This affected all steel I-girder and U-girder design and rating requests for all codes under 

the specified conditions. 

 83255 An incident was resolved for the AASHTO LRFD Multicell ConcBox and Precast-I Comp bridge 

design and rating shear resistance calculation reports where the evaluation of effective depth to the 

centroid "de" of the tensile reinforcement per AASHTO LRFD 5.8.2.9-2 was incorrect. Previously 

the area of the prestress tendons (PT) was reported as zero if the centroid of the tendons was located 

on the compression side of the neutral axis. Now the area of PT is reported as zero when the 

centroid of the tendons is located in the equivalent rectangular concrete compressive stress block as 

defined in AASHTO 5.7.2.2. This affected the reported values of "de" and "dv". The impacted 

regions were areas where the centroid of the tendons was in the flexural compression zone. This 

was a reporting error that only affected the calculation reports. No other design results were 

affected. 

 
Results Display and Output 
Incidents Resolved 

* Incident Description 

* 38919 An incident was resolved where the option "Provide Output" in the definition of a staged 

construction load case had no effect. Results were provided for every stage regardless of the setting. 

Now setting this option to "No" will cause the stage to produce no output except for the last stage or 

for stages with target-force loading, for which output will always be provided. The default value for 

this setting when defining a load case has been changed from "No" to "Yes". Models from previous 

versions, when opened in the new version, will have this option set to "Yes" for all stages in any 

load case where all stages were previously set to "No". Otherwise the settings will not be changed, 

but the number of output steps produced may differ between the new version and the old version. 

 81021 An incident was resolved where in some instances the data shown in a report may appear in the 

wrong column. This was a report creation error only and did not affect the results as displayed in the 

tables or on the model. 
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* Incident Description 

 81511 An incident was resolved where the girder displacement plotted in the Bridge Object Response 

Display form could be calculated incorrectly for composite bridges (steel or precast I- or U-girders) 

in regions where the longitudinal meshing of the slab area objects changed in the transverse 

direction of the slab. For example, if between two transverse section cuts the analysis model for the 

slab had three shell elements on the left side of the bridge and two shell elements on the right side of 

the bridge, say due to skew or curvature of the layout line, girder displacements at those section cuts 

could be incorrect. This error was limited to the bridge girder displacements in the vicinity of the 

mesh changes and did not affect any other results. Bridge objects without sub-meshing were not 

affected. The error was generally small as the displacement was being plotted for a point near the 

expected point. Stage-construction load cases were the most likely to be significantly affected. 

 83281 An incident was resolved for Bridge Design where generated calculation reports were corrupt and 

unable to opened in Microsoft Word when any of the design or rating request names referenced in 

the report contained the characters "&" "<" or ">". No results were affected. 

Database Tables 
Incidents Resolved 

* Incident Description 

 81242 An incident was resolved where the interactive database import of the Bridge Parametric Variation 

Definitions table may result in duplicate records being added to the table. 

 82301 An incident was resolved in which exporting the Frame Loads - Temperature database table would 

export the table without any values in the temperature column. This was a database export issue 

only and did not affect results. 

 82355 An incident was resolved for interactive database editing where a table edited in Excel and then 

brought back to the editor form could display incorrectly if the scroll bar is visible. When this 

occurred the scroll bar did not function correctly and some rows could appear to be missing. This 

was a display issue only. The data was correct and no results were affected. 

* 83178 An incident was resolved where tables exported to Excel using the command File > Export > Excel 

could, under certain regional settings, produce incorrect values in the Excel file. Values were 

previously being exported as text in full precision, and the decimal separator could be lost. Now 

values are exported as numerical double-precision values to avoid this problem. This error only 

affected versions 17.2.0 and 17.3.0. When this occurred the error was usually obvious because the 

values could be incorrect by orders of magnitude. This error only affected the File > Export 

command. It did not affect Excel tables produced using the Home > Display > Show Tables > 

Export Current/All Tables command nor the Excel tables accessed from the command Advanced > 

Edit > Interactive Database Editor > Send Table to Excel. 

Data Files 
Incidents Resolved 

* Incident Description 

 71574 An incident was resolved in which the CSiLoadOptimizer could not open its file when the regional 

settings on the machine used a comma as the decimal separator, but the data in the file used a 

decimal point. 

 81192 An incident was resolved where the Bridge Seismic Design Preferences - AASHTO Seismic 2011 

table did not import correctly. 

 83635 An incident was resolved in which the import of vehicles and/or precast concrete I- and U-girder 

frame sections from XML files did not work when the regional settings on the computer were set to 

use a comma as the decimal separator. Note that the format of these files always uses the period as 

the decimal separator regardless of the regional settings. Now the files are written and read 

independently of the regional settings to accommodate this. 
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Application Programming Interface 
Incidents Resolved 

* Incident Description 

 84753 An incident was resolved for the Application Programming interface (API) where calling the 

function SapObject.SetAsActiveObject() on an instance of SapObject that had previously been set 

as the active instance caused subsequent calls to SetAsActiveObject() on all other SapObject 

instances to fail. Consequently, no other SapObject instance could be set as the active instance until 

the active SapObject instance was destroyed by closing the program or calling the function 

SapObject.ApplicationExit(). No results were affected. 

 


